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02VR & AR 
Wie nutzt man VR & AR 
jenseits vom Hype?  

Motion Graphics  
Prozedurale Grafiken, 
Audio-Cues & neue Tools 

Tools & Tricks! 
Avid MC, Lightworks, 
Houdini, Blender & mehr 
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Das Add-on „Animation Nodes“ hat sich in der Motion-Graphics-Fraktion inzwischen so weit etabliert, dass es aufgrund 
der hohen Nachfrage von Renderfarmen unterstützt wird. Währenddessen schreiten die Arbeiten an Version 2.O voran, 
die neben deutlich besserer Performance auch neue, weniger technische Workflows bieten wird. Grund genug also für 
DP, mal wieder einen Blick darauf zu werfen, den Workshop aus Ausgabe O4:2O16 fortzuführen und einen Ausblick auf 
die Zukunft der Animation Nodes zu werfen.� von Gottfried Hofmann

Die Animation Nodes in Blender erfüllen 
zuallererst den Zweck, Animationen 
prozedural zu erzeugen. Eher nebenbei 

sind Hilfsmittel für prozedurale Modellierung 
vorhanden. Eine große Anzahl der Nodes ist 
dafür gedacht, Attribute und Einstellungen in 
Blender auszulesen und zu schreiben. Damit 
sind die Animation Nodes auch ein mächtiger 
Ersatz für Driver. Zu guter Letzt fügen die 
Animation Nodes neue Funktionen hinzu und 
vereinfachen manche Aufgaben in Blender 
ganz extrem. Einen Einblick haben wir be-
reits im Workshop in Ausgabe DP 04:2016 
gegeben, wo die Text-Werkzeuge der Ani-
mation Nodes vorgestellt wurden. Mit deren 
Hilfe wurde die individuelle Animation von 
Buchstaben ein Kinderspiel. Den Workshop 
können Sie kostenlos unter bit.ly/anima- 
tionnodes herunterladen. Dort finden Sie 
auch die .blend-Dateien für diesen Workshop.

Clones

In dieser Ausgabe wollen wir ein weiteres 
Basiswerkzeug für Motion Graphics mittels 
Animation Nodes implementieren: Ein Sys-

tem zum Klonen von Objekten. Gegenüber 
dem Array Modifier in Blender wird das Er-
gebnis einige Vorteile bieten. Die kopierten 
Objekte werden Instanzen des Ursprungsob-
jekts bilden. Dadurch können diese effizient 
mit Cycles gerendert werden und verbrau-
chen fast keinen Speicher. Die Eigenschaften 
der Instanzen können zudem mit einer Art 
Delta bearbeitet werden, wie z.B. ein zu-
fälliger Offset oder eine andere Farbe. Da 
Animation Nodes sehr flexibel sind, kann der 
fertige Aufbau auch mit dem Setup zur indi-
viduellen Animation von Buchstaben aus der 
DP 04:2016 kombiniert werden.

Coin Stack

Als konkretes Beispiel für die Anwendung 
eines Array Modifiers mit Offset ziehen 
wir einen Stapel Münzen heran, der an-
hand eines Eingabewertes wachsen und 
schrumpfen kann. Konkret arbeiten wir 
mit Version 1.6 der Animation Nodes, die 
direkt von Github bezogen werden kann  
(https://github.com/JacquesLucke/anima-
tion_nodes/releases).

Wir starten mit einem Zylinder, den wir im 
Edit Mode auf 5% seiner Z-Höhe skaliert 
haben (S Z 0,05), und einem frischen Ani-
mation Nodes Tree. Auto Execution lassen 
wir eingeschaltet, das Häkchen bei „Always“ 
entfernen wir aber, damit die Animation 
Nodes nicht die komplette Zeit über einen 
CPU-Kern zu 100% auslasten. Stattdessen 
setzen wir Häkchen bei den drei übrigen 
Triggern, damit wir ein Update sehen, sobald 
wir etwas verändern.

Um das Klonen von Objekten kümmert 
sich der Node „Object Instancer“. Fügen 
Sie diesen hinzu (Object > Instancer) und 
wählen Sie den Zylinder bzw. die Münze im 
Objekt-Drop-down aus. Jetzt können Sie 
mittels „Instances“ eine beliebige Anzahl an 
Duplikaten erzeugen, diese sind aber alle am 
gleichen Ort wie das ursprüngliche Objekt. 
Sie können diesen Sachverhalt überprüfen, 
indem Sie im Viewport mehrfach versuchen, 
die Zylinder anzuwählen. Sie werden fest-
stellen, dass sich jetzt mehrere Objekte an 
derselben Stelle befinden. Diese tragen Na-
men wie „instance_gbfos_0“. Sie können die 
Instanzen auch verschieben. Sie sehen dann 

Animation Nodes Reloaded

Subsumierung – Mit den Animation Nodes 
lässt sich die Funktion anderer Add-ons 
in Blender nachbauen und in bestehende 
Setups integrieren. Dieses Beispiel wurde 
ursprünglich mit ARewO erstellt.
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die Parent-Linie von den Instanzen zu einem 
unsichtbaren Container-Objekt, welches das 
Elternteil aller von den Animation Nodes 
erzeugten Objekte ist und die Bezeichnung 
„Animation Nodes Object Container“ trägt. 
Dadurch bleibt nicht nur der Outliner aufge-
räumt, Sie können damit auch wenn nötig 
die gesamte Szene von den durch die Ani-
mation Nodes erzeugten Objekten reinigen.

Manuelles Verschieben ist aber nicht das, 
wofür die Animation Nodes entwickelt wur-
den. Um die Münzen platzieren zu können 
benötigen wir eine Schleife bzw. einen Loop, 
der über die Liste der Objekte iteriert. Dass die 
Ausgabe der Object-Instancer-Node eine Li-
ste ist, erkennt man daran, dass der Ausgabe-
Socket ein wenig durchsichtig ist, was für alle 
Listen in den Animation Nodes gilt.

Iterator

Einen Iterator über eine Liste erzeugt man 
in den Animation Nodes in zwei Schritten: 
Zuerst erstellt man ein sogenanntes „Sub-
program“ und wählt dort „Loop“ aus. Dann 
erzeugt man einen Node, mit dem die so 

erzeugte Funktion aufgerufen werden kann.
Fügen Sie ein Loop-Subprogram hinzu (Sub-
programs > Loop). Dem neu erzeugten Node 
kann man ganz unten einen Namen geben, 
z.B. „Placer“. Das sollten Sie auch gleich ma-
chen, damit Sie später anhand des Namens 
die Funktion aufrufen können.

Um die Position der Instanzen zu verän-
dern, wird ein „Object Transforms Output“-
Node benötigt (Object > Transforms Output). 
Fügen Sie diesen hinzu und verbinden Sie 
den Eingang bei „Object“ mit dem Ausgang 
„New Iterator“ des „Loop Input“-Nodes. Der 
„Object Transforms Output“-Node hat nun 
seine Farbe an die des „Loop Input“-Nodes 
angepasst. Durch die automatische Farbko-
dierung können Sie leicht erkennen, welche 
Nodes zu welchen Funktionen bzw. Unter-
programmen gehören.

Noch ist aber nichts im 3D-View passiert. 
Das hat zwei Gründe: Zum einen wird das er-
zeugte Unterprogramm noch nicht aufgeru-
fen, zum anderen ändert der „Object Trans-
forms Output“-Node noch nichts. Um das 
Unterprogramm aufzurufen, fügen Sie einen 
„Invoke Subprogram“-Node hinzu (Subpro-

grams > Invoke Subprogram). Sie können 
das Unterprogramm entweder direkt in der 
Liste auswählen oder zunächst einen allge-
meinen „Invoke Subprogram“-Node hinzu-
fügen und dann die Funktion in dem Node 
mittels „Choose“ auswählen. Wählen Sie in 
beiden Fällen die eben erzeugte Schleife.

Der „Invoke Subprogram“-Node hat jetzt 
einen neuen Eingang erhalten und die glei-
che Farbe wie die Nodes, die die Schleife 
definieren. Verbinden Sie den Ausgang des 
„Object Instancer“-Nodes mit dem Eingang. 
Jetzt iteriert die Schleife über die instanziier-
ten Objekte, ohne diese zu verändern.

Um die Position der Klone zu modofizie-
ren, muss zunächst bei dem „Object Trans-
forms Output“-Node eingeschaltet werden, 
dass diese die Position verändert. Wählen 
Sie die drei Häkchen bei „Location“ an und 
ein neuer Eingangs-Socket erscheint. Es 
handelt sich dabei um einen Vektor, der die 
gewünschte Position der Klone annimmt.

Jetzt bleibt noch die Frage, woher die-
se Position genommen werden soll. Der 
„Index“-Ausgang des „Loop Input“-Nodes 
bietet sich dafür an, denn er gibt für jedes 

Globale Kontrolle – Mit den Animation Nodes 
können Attribute global kontrolliert werden. In 
diesem Beispiel werden Shape Keys, Materialien 
und die Bewegung der Augen synchron animiert, 
zusätzlich bewegen sich die Augen dank Wiggle 
noch ein wenig auf und ab. Die Beleuchtung 
könnte aber mit wenigen Klicks ebenfalls inte-
griert werden. Änderungen an der Animation 
werden so zum Kinderspiel. Tutorial dazu: 
http://www.blenderdiplom.com/de/tutorials/
all-tutorials/634-animation-nodes-target-
tracking.html.
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Objekt eine andere Zahl aus (0 für das erste, 
1 für das zweite usw.). Verbinden Sie „In-
dex“ mit „Location“. Es wird automatisch 
ein Node zwischengeschaltet, da der In-
dex ein Integer ist, die Location hingegen 
ein Vektor. Der zwischengeschaltete Node 
„Combine Vector“ erzeugt einen Vektor aus 
den drei Eingaben. Jetzt verteilen sich die 
Münzen entlang der X-Achse, denn der Index 
wird automatisch mit dem obersten Socket, 
sprich dem Wert für die X-Achse, verbun-
den. Verbinden Sie den Index stattdessen 
mit dem Eingang für die Z-Achse, damit sich 
die Münzen nach oben stapeln.

Noch finden sich große Lücken zwischen 
den Münzen. Für einen richtigen Stapel 
muss der Abstand verkleinert werden. Das 
erreichen Sie mit einem Mathematik-Node 
(Number > Math). Setzen Sie diesen zwi-
schen „Index“ und „Combine Vector“. Er ist 
bereits auf „Multiply“ eingestellt. Wenn Sie 
die untere Zahl ändern, verändert sich der 
Abstand entsprechend. Setzen Sie den Ab-
stand z.B. auf 0,11, damit die Münzen fast 
aufeinander liegen (siehe obere Abbildung).

Sie haben jetzt einen Stapel Münzen, 
dessen Höhe Sie über die „Instances“ des 
„Object Instancer“-Nodes beeinflussen kön-
nen. Was jetzt noch fehlt ist eine Option, 
mit der die Münzen leicht versetzt gestapelt 
werden können. Diese Erweiterung lässt sich 
mit wenig Aufwand realisieren.

Offset

Der Offset soll zufällig in X- und Y-Richtung 
gehen. Dafür eignet sich ein randomisierter 
Vektor, denn der besteht quasi aus drei zufäl-

Der erste Schritt – Der Münzstapel kann be-
reits nach oben wachsen, es fehlt aber noch 
der zufällige Offset. Links oben im Bild die 
empfohlenen Einstellungen für Auto Executi-
on, rechts oben ist der Animation Nodes Object 
Container im Outliner selektiert und ausge-
klappt, sodass man seine Kind-Objekte sieht.

Offset per Zufall – Mit einer kleinen 
Erweiterung sind die Münzen zufällig 
auf der X- und Y-Achse verschoben.

Rotation per 
Zufall – Auch 
die Rotation 
entlang der  
Z-Achse  
lässt sich  
randomisieren.
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ligen Zahlen, von denen wir zwei brauchen. 
Fügen Sie einen „Random Vector“-Node hin-
zu (Vector > Randomize) und verbinden Sie 
den Eingang von „Seed“ mit dem „Index“ des 
„Loop Input“-Nodes. Jetzt erhält jede Münze 
einen eigenen, zufälligen Vektor mit maxima-
ler Länge wie unter „Scale“ angegeben. Dank 
der automatischen Konvertierung bei Anima-
tion Nodes können Sie den „Vector“-Ausgang 
direkt mit dem „X“-Eingang des „Combine 
Vector“-Nodes verbinden. Wie durch Zauber-
hand erscheint ein neuer Node dazwischen: 
„Separate Vector“. Noch sind lediglich die 
beiden X-Komponenten verbunden. Verbin-
den Sie zudem noch die Y-Komponenten, so 
verschieben sich die Münzen zufällig auf dem 
Stapel, allerdings noch viel zu extrem. Redu-
zieren Sie die „Scale“ des „Random Vector“-
Nodes auf z.B. 0,10, damit die Münzen ledig-
lich ein wenig verschoben sind (siehe mittlere 
Abbildung links).

Rotation

Die Rotation der Mün-
zen kann ebenfalls 
zufällig variieren. Das 
sollte aber nur entlang 
der Z-Achse geschehen. 
Setzen Sie im „Object 
Transforms Output“-
Node daher bei Rotation 
nur das dritte Häkchen. 
Wenn Sie den Node ein 
wenig breiter ziehen, 
werden sie feststellen, 
dass neben den Boxen 
jeweils die Achse an-
gegeben ist, in diesem 
Fall die Z-Achse. Es er-
scheint ein neuer Eingang mit drei Werten. 
Da Sie aber nur das Häkchen bei Z gesetzt 
haben, wird nur der dritte Kanal einen Ein-
fluss haben.

Der Eingangs-Socket ist dunkelblau. Das 
bedeutet, dass er eine Rotation erwartet. 
Im Nodes-Menü finden Sie unter „Rotation“ 
den Eintrag „Random Euler“. Fügen Sie die-
sen hinzu und verbinden Sie „Seed“ wieder 
mit dem „Index“-Ausgang des „Loop Input“-
Nodes. Da Sie die Rotation im „Objects 
Transforms Output“-Node auf die Z-Achse 
beschränkt haben, können Sie den „Euler“-
Ausgang direkt mit dem „Rotation“-Eingang 
verbinden. Jetzt werden alle Münzen zufällig 
entlang der Z-Achse rotiert. Der Wert „Sca-
le“ des „Random Euler“-Nodes nimmt Ra-
dianten als Eingabe. Wenn Sie dort „2*pi“ 
eingeben, erhalten Sie die Entsprechung für 
eine maximale Rotation von 360 Grad in Ra-
dianten, denn das Eingabefeld funktioniert 
wie ein Taschenrechner. Das ist praktisch bei 
allen Eingabefeldern für Zahlen in Blender 
der Fall.

Fazit

Einen Array Modifier mit Offset – das wün-
schen sich viele für Blender. Mit den Anima-
tion Nodes wird dieser Wunsch Wirklichkeit 
und lässt sich noch um zusätzliche Features 
erweitern. Der Artikel zeigt aber mal wieder 
nur einen winzigen Teil der Mächtigkeit des 
Add-ons auf - die Spitze der Spitze des Eis-
bergs sozusagen.� › ei

Einlesen von Werten aus Datei – Ein weiteres Feature der Animation Nodes, das es sich zu evaluieren 
lohnt: Die Inhalte von Textdateien oder Textblöcken in Blender können eingelesen werden. Die Mög-
lichkeiten zum Parsen sind allerdings noch sehr low-level. Man kann sich aber z.B. einen eigenen CSV-
Reader zusammenklicken. Das von Kmeirlaen und Rohan Dalvi inspirierte Beispiel nutzt ein reguläres 
Säulendiagramm, eine Erweiterung des Münzenstapels ist aber ebenfalls denkbar.

Gottfried Hofmann ist Diplom-Informa-
tiker. Er arbeitet als Freelancer in den 
Bereichen Visualisierung und VFX sowie 
als Trainer und Consultant für die freie 
3D-Software Blender. Als freischaffender 
Autor schreibt er für Fach- und Compu-
terzeitschriften. Er hat zahlreiche Blen-
der-Tutorials verfasst, u.a. für CG Tuts+ 
und CG Cookie. Weiterhin betreibt er die 
Webseite www.BlenderDiplom.com, auf 
der Blender-Tutorials in deutscher und 
englischer Sprache zur Verfügung stehen.

Die nächste Version der Animation Nodes 
(Version 2.O) wird  zwei große Neue-
rungen bereitstellen. Zum einen wird 
sie nicht mehr ausschließlich in Python, 
sondern an Performance-kritischen 
Stellen auch in Cython implementiert 
sein. Das bedeutet, dass man das Add-on 
nicht mehr einfach so herunterladen 
und installieren kann. In Zukunft wird 
man auch auf das Betriebssystem achten 
müssen. Sprich, es wird eine Version der 
Animation Nodes für Windows, eine für 
Linux und eine für Mac OS geben. Im Ge-
genzug wird man mit einem deutlichen 
Zuwachs an Performance belohnt.
Weiterhin wird ein Feature Einzug halten, 
das bei einigen Aufgaben die Anzahl 
der benötigten Loops reduzieren und 
damit die Arbeit erleichtern wird: Falloffs. 

Manche Nodes werden eine Art Einflussbereich erhalten, der z.B. über Empties kontrolliert werden kann. Das 
Erleichtert die Erstellung gängiger Motion Graphics wie einfliegende Buchstaben oder die Bewegung einer 
großen Anzahl von Objekten relativ zu einem Controller-Element. Preview-Builds finden sich auf Graphicall.
org als Animation Nodes Version 1.7. In diesem Beispiel kontrolliert ein Empty die Skalierung und Rotation 
hunderter Einzelteile, die per Cell Fracture aus einem Objekt erstellt wurden. Damit kann eine Animation 
erstellt werden, wie sich ein Objekt aus zahllosen Scherben wieder zusammensetzt (oder umgekehrt). Dabei 
wird keine einzige Schleife benötigt, da die Nodes für Zufallswerte jetzt auch Listen ausgeben können (der 
Node für zufällige Rotationen leider noch nicht, weshalb in diesem Beispiel ein Vektor-Node mit  dazuge-
schaltetem Konverter eingesetzt wird). Die neu hinzugekommenen Offset-Nodes iterieren automatisch über 
die Listen anhand eines Falloffs, der sehr frei definiert werden kann. Hier erfolgt das über ein Objekt, das das 
Zentrum des Falloffs angibt. Wie genau er abfällt, wird über eine Interpolationskurve beschrieben. Vielen Dank 
an Jacques Lucke, den Entwickler der Animation Nodes, für das Beispiel. 

Ausblick auf Version 2.O der Animation Nodes
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